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Paper Set 1 · 02 Jun 2026 · 12:30 PM - 2:00 PM · OSSSC CRE 2025 (Odia)

Quant

✓

Q1 Quant
72 cm × 54 cm × 24 cm ଆକାର ବି ଶି ଷ୍ଟ ଏକ ଆୟତଘନାକାର ଟାଙ୍କି  ପାଣି ରେ ଅଧା
ପୂ ର୍ଣ୍ଣ  ଅଟେ । ଟାଙ୍କି ରେ ଏକ ନି ଦା ସମଘନକୁ  ବୁ ଡାଇଦି ଆଯାଏ ଯାହା ଦ୍ଵାରା ପାଣି  ଧାର ପର୍ଯ୍ୟ ନ୍ତ
ଉପରକୁ  ଉଠି ଯାଏ । ସମଘନର ଧାର ନି ର୍ଣ୍ଣ ୟ କର ।

A.  27 cm

B.  29 cm

C.  32 cm

D.  36 cm

✓

Q2 Quant
X, Y ଓ Z ଗୋଟି ଏ ବ୍ୟବସାୟ ଆରମ୍ଭ କରି ଥି ଲେ । X ଙ୍କ ପୁ ଞ୍ଜି  Z ଙ୍କ ପୁ ଞ୍ଜି ର 10 ଗୁ ଣ ଏବଂ Y
ଙ୍କ ପୁ ଞ୍ଜି  X ଙ୍କ ପୁ ଞ୍ଜି ର 2 ଗୁ ଣ ଅଟେ । ଯଦି  ଲାଭ ₹1,11,600 ହୁ ଏ, ତେବେ Z ଙ୍କ ଅଂଶ
କେତେ?

A.  ₹3,500

B.  ₹3,550

C.  ₹3,600

D.  ₹3,650

✓

Q3 Quant
ଜଣେ ବି କ୍ରେ ତା 20 ଟଙ୍କାରେ 16 ଟି  ଟଫି  କି ଣି ଥି ଲେ । 20% ଲାଭ ପାଇଁ  ସେ 3 ଟଙ୍କାରେ
କେତୋଟି  ଟଫି  ବି କ୍ରି   କରି ବା ଉଚି ତ?

A.  1

B.  2

C.  3

D.  6

✓

Q4 Quant
30, 39, 7.5 ଓ 9 ପ୍ର ତ୍ୟେକ ସଂଖ୍ୟାରୁ  କେଉଁ  ସଂଖ୍ୟା ବି ୟୋଗ କଲେ ବି ୟୋଗଫଳଗୁ ଡ଼ି କ
ସମାନୁ ପାତୀ ହେବେ?

A.  1

B.  2

C.  3

D.  4

✓

Q5 Quant
ନି ମ୍ନ ଲି ଖି ତ କେଉଁ  ସଂଖ୍ୟାଟି  12, 15, 18 ଓ 20 ର ଲଘି ଷ୍ଠ ସାଧାରଣ ଗୁ ଣି ତକ ଅଟେ?

A.  60

B.  90

C.  120

D.  180

✓

Q6 Quant
ଗଣି ତ କ୍ଳାସରେ ଜଣେ ବି ଦ୍ୟାର୍ଥୀ ଙ୍କ ଅନ୍ତି ମ ଗ୍ରେ ଡ ନି ମ୍ନ ଲି ଖି ତ ଉପାଦାନ ଏବଂ ଭାର ଉପରେ
ଆଧାରି ତ
ନି ଯୁ କ୍ତି : 20%
ପ୍ର ଶ୍ନ : 30%
ମଧ୍ୟମ ପରୀକ୍ଷା: 25%
ଶେଷ ପରୀକ୍ଷା: 25%

ବି ଦ୍ୟାର୍ଥୀ ଙ୍କ ସ୍କୋର ଥି ଲା (100 ରୁ )
ନି ଯୁ କ୍ତି : 90%
ପ୍ର ଶ୍ନ : 85%
ମଧ୍ୟମ ପରୀକ୍ଷା: 78%
ଅନ୍ତି ମ ପରୀକ୍ଷା: 82%

ବି ଦ୍ୟାର୍ଥୀ ଙ୍କ ଅନ୍ତି ମ ଭାରି ତ ହାରାହାରି  ଗ୍ରେ ଡ କେତେ?

A.  83.5%

B.  81.5%

C.  76.5%

D.  79.5%

✓

Q7 Quant
ଯଦି  ଜଣେ ବ୍ୟକ୍ତି  ₹2500 ରୋଜଗାର କରନ୍ତି  ଏବଂ ₹1300 ଖର୍ଚ୍ଚ  କରନ୍ତି , ତେବେ ତାଙ୍କ
ସଞ୍ଚୟ ତାଙ୍କ ଆୟର କେତେ ପ୍ର ତି ଶତ ଅଟେ?

A.  42%

B.  48%

C.  52%

D.  56%

✓

Q8 Quant
ଏକ ସଂଖ୍ୟାର ଦୁ ଇଗୁ ଣ, ସେହି  ସଂଖ୍ୟାର ଦୁ ଇ-ତୃ ତୀୟାଂଶ ଠାରୁ  72 ଅଧି କ ଅଟେ । ସଂଖ୍ୟାଟି
କେତେ?

A.  48

B.  54

C.  96

D.  24

✓

Q9 Quant
ଜଣେ ବ୍ୟକ୍ତି  ଯଥାକ୍ର ମେ 15 km/hr, 20 km/hr ଓ 25 km/hr ବେଗରେ ତି ନୋଟି  ସମାନ
ଦୂ ରତା ଅତି କ୍ର ମ କରନ୍ତି  । ସମଗ୍ର  ଯାତ୍ରା ର ହାରାହାରି  ବେଗ କେତେ? (ଦଶମି କ ଦୁ ଇ ସ୍ଥାନ
ପର୍ଯ୍ୟ ନ୍ତ ପୂ ର୍ଣ୍ଣା ଙ୍କି ତ କରନ୍ତୁ)

A.  17.65 km/hr

B.  20.48 km/hr

C.  22.51 km/hr

D.  19.15 km/hr
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✓

Q10 Quant
ଯଦି  ଏକ ଡାଟାସେଟରେ ଥି ବା ସମସ୍ତ ଲବଧାଙ୍କର ଭାର କୁ  3 ଦ୍ୱାରା ଗୁ ଣନ କରାଯାଏ,
ତେବେ ଉକ୍ତ ଡାଟାସେଟର ଭାରି ତ ମାଧ୍ୟମାନରେ କି ପରି  ପରି ବର୍ତ୍ତ ନ ଘଟି ବ?

A.  ଏହା ମୂ ଳ ଭାରି ତ ମଧ୍ୟମାନର ତି ନି  ଗୁ ଣ ହୋଇଯି ବ

B.  ଏହା ଅପରି ବର୍ତ୍ତିତ ରହି ବ

C.  ଏହା ମୂ ଳ ଭାରି ତ ମଧ୍ୟମାନର ଏକ-ତୃ ତୀୟାଂଶ ହୋଇଯି ବ

D.  ଏହା ମୂ ଳ ଭାରି ତ ମଧ୍ୟମାନର ନଅ ଗୁ ଣ ହୋଇଯି ବ

✓

Q11 Quant
ଦୁ ଇଟି  ସଂଖ୍ୟାର ଅନୁ ପାତ 12:19 ଅଟେ । ଯଦି  ପ୍ର ତ୍ୟେକରେ 24 ଯୋଗ କରାଯାଏ, ତେବେ
ଅନୁ ପାତ 16:23 ହୋଇଯାଏ । ସଂଖ୍ୟାଗୁ ଡି କ ମଧ୍ୟରେ ଧନାତ୍ମକ ଅନ୍ତର କେତେ?

A.  24

B.  32

C.  42

D.  56

✓

Q12 Quant
ଯଦି  ଗୋଟି ଏ ସଂଖ୍ୟାର 20% କୁ  36 ସହି ତ ଯୋଗ କରାଯାଏ, ତେବେ ଫଳାଫଳ ସମାନ
ସଂଖ୍ୟା ହେବ । ସମାନ ସଂଖ୍ୟାର 60% କେତେ?

A.  27

B.  18

C.  57

D.  47

✓

Q13 Quant
ଜଣେ ଦୋକାନୀ ଏକ ଜି ନି ଷର ଚି ହ୍ନି ତ ମୂ ଲ୍ୟକୁ  ତାହାର କ୍ର ୟ ମୂ ଲ୍ୟ ଠାରୁ  50% ଅଧି କ ସ୍ଥି ର
କରନ୍ତି  । 8% ଲାଭ ଅର୍ଜ ନ କରି ବା ପାଇଁ  ଚି ହ୍ନି ତ ମୂ ଲ୍ୟ ଉପରେ କେତେ ପ୍ର ତି ଶତ ରି ହାତି
ଦି ଆଯି ବା ଉଚି ତ?

A.  28%

B.  27%

C.  30%

D.  29%

✓

Q14 Quant
କାର୍ତ୍ତିକଙ୍କ ପାଖରେ ₹1281 ଅଛି  । ସେ ଏହାକୁ  ତାଙ୍କ ପୁ ଅ ଇଶାନ ଏବଂ କ୍ରି  ଶଙ୍କ ମଧ୍ୟରେ
ବାଣ୍ଟି  ଦେଲେ ଏବଂ ସେମାନଙ୍କୁ  ବାର୍ଷିକ 10% ଚକ୍ର ବୃ ଦ୍ଧି  ସୁ ଧ ହାରରେ ନି ବେଶ କରି ବାକୁ
କହି ଲେ । ଦେଖାଗଲା ଯେ ଇଶାନ ଏବଂ କ୍ରି  ଶ ଯଥାକ୍ର ମେ 19 ଏବଂ 20 ବର୍ଷ  ପରେ ସମାନ
ସମୂ ଳସୁ ଧ ପାଇଲେ । କାର୍ତ୍ତିକ କ୍ରି  ଶଙ୍କୁ  କେତେ ଟଙ୍କା (₹ ରେ) ଦେଇଥି ଲେ?

A.  610

B.  671

C.  460

D.  771

✓

Q15 Quant
9 cm ବ୍ୟାସାର୍ଦ୍ଧ  ଏବଂ 18 cm ଉଚ୍ଚତା ବି ଶି ଷ୍ଟ ଏକ ନି ଦା ସି ଲି ଣ୍ଡରର ସମଗ୍ର  ପୃ ଷ୍ଠତଳର
କ୍ଷେତ୍ର ଫଳ କେତେ?

A.  486π cm2

B.  396π cm2

C.  564π cm2

D.  424π cm2

✓

Q16 Quant
ନି ତି ନ ଓ ପ୍ର ବୀଣ ଏକାଠି  ଏକ ହଲକୁ  3 ଦି ନରେ ରଙ୍ଗ କରି ପାରନ୍ତି  । ନି ତି ନ ଏକାକୀ ଏହାକୁ  6
ଦି ନରେ ରଙ୍ଗ କରି ପାରି ବେ । ଏକାକୀ ପ୍ର ବୀଣ କେତେ ଦି ନରେ ଏହି ପରି  16 ଟି  ହଲକୁ  ରଙ୍ଗ
କରି ପାରି ବେ?

A.  96

B.  95

C.  97

D.  94

✓

Q17 Quant
ଅଙ୍କି ତା କି ଛି  ବେଗରେ ଏକ ନି ର୍ଦ୍ଦିଷ୍ଟ ଦୂ ରତା ଯାତ୍ରା  କରି ଥି ଲେ । ଯଦି  ସେ 6 km/hr ଦ୍ରୁ ତ
ବେଗରେ ଗତି  କରି ଥାନ୍ତେ, ତେବେ ତାଙ୍କୁ  80 ମି ନି ଟ କମ ସମୟ ଲାଗି ଥାନ୍ତା । ଯଦି  ସେ 4
km/hr ମନ୍ଥର ବେଗରେ ଗତି  କରି ଥାନ୍ତେ, ତେବେ ତାଙ୍କୁ  80 ମି ନି ଟ ଅଧି କ ସମୟ ଲାଗି ଥାନ୍ତା
। ଦୂ ରତା (km ରେ) କେତେ?

A.  40

B.  80

C.  160

D.  200
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✓

Q18 Quant
A ଗୋଟି ଏ କାର୍ଯ୍ୟ କୁ  8 ଦି ନରେ ଶେଷ କରି ପାରି ବ, B ସେହି  ସମାନ କାମକୁ  11 ଦି ନରେ ଶେଷ କରି ପାରି ବ । ଯଦି  ଉଭୟ ଏକାଠି  କାମ ଆରମ୍ଭ କରନ୍ତି , ତେବେ 4 ଦି ନରେ କେତେ କାମ ହେବ?

A.  

B.  

C.  

D.  

✓

Q19 Quant
ଦୁ ଇଟି  ସଦୃ ଶ ତ୍ରି  ଭୁ ଜର ଦୁ ଇଟି  ଅନୁ ରୂ ପ ବାହୁ ର ଦୈ ର୍ଘ୍ୟ ର ଅନୁ ପାତ 8 : 1 ଅଟେ । ତେବେ ଉକ୍ତ କ୍ର ମରେ ସେହି  ତ୍ରି  ଭୁ ଜ ଦ୍ୱୟର କ୍ଷେତ୍ର ଫଳର ଅନୁ ପାତ କେତେ?

A.  64 : 1

B.  8 : 1

C.  

D.  1 : 64

✓

Q20 Quant

ସରଳ କର

A.  28

B.  31

C.  25

D.  29
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GA

✓

Q21 GA
ଜୁ ଲାଇ 2025 ରେ ନି ମ୍ନ ଲି ଖି ତମାନଙ୍କ ମଧ୍ୟରୁ  କି ଏ ଭାରତର 87ତମ ଗ୍ରା ଣ୍ଡମାଷ୍ଟର
ହୋଇଥି ଲେ?

A.  ହରି କୃ ଷ୍ଣନ୍  ଏ ରା

B.  ଆର. ପ୍ର ଜ୍ଞାନନ୍ଦା

C.  ଅର୍ଜୁ ନ ଏରି ଗାଇସି

D.  ବି ଦି ତ ଗୁ ଜୁ ରାଟି

✓

Q22 GA
ଓଡ଼ି ଶାର ନି ମ୍ନ ଲି ଖି ତ ଜି ଲ୍ଲାଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  କେଉଁ  ଜି ଲ୍ଲାରେ ମାଙ୍ଗାନି ଜ ର ପ୍ର ମୁ ଖ ଭଣ୍ଡାର
ନାହିଁ?

A.  କେନ୍ଦୁ ଝର

B.  ରାୟଗଡା

C.  ବଲାଙ୍ଗୀର

D.  ଯାଜପୁ ର

✓

Q23 GA
ନି ମ୍ନ ଲି ଖି ତ କେଉଁ  ଉତ୍ତଳ ଲେନ୍ସ ର ଫୋକସ ଦୂ ରତା ସର୍ବା ଧି କ ଅଟେ?

A.  ପାୱାର +2D 

B.  ପାୱାର +5 D

C.  ପାୱାର +10 D

D.  ପାୱାର +20 D

✓

Q24 GA
ଯଦି  ଏକ ଉଦ୍ଭି ଦର କାଣ୍ଡରେ ଥି ବା ଫ୍ଲୋ ଏମ (phloem) ଟି ସୁ  କ୍ଷତି ଗ୍ର ସ୍ତ ହୁ ଏ, ତେବେ ଉଦ୍ଭି ଦ
ଉପରେ ଏହାର ସମ୍ଭାବ୍ୟ ପ୍ର ଭାବ କ’ଣ ହୋଇପାରେ?

A.  ଜଳ ଯୋଗାଣ ହ୍ରା ସ ପାଇଥି ବାରୁ  ପତ୍ର  ମଉଳି  ଯି ବ

B.  ପତ୍ର ରେ ଖାଦ୍ୟ ଜମା ହେବ ଏବଂ ମୂ ଳ ଠି କ୍  ଭାବରେ ବଢ଼ି ବା ବନ୍ଦ ହୋଇଯି ବ।

C.  ଖଣି ଜ ଲବଣର ଅଭାବ ଯୋଗୁଁ  ଉଦ୍ଭି ଦଟି  ତୁ ରନ୍ତ ଶୁ ଖି ଯି ବ

D.  ଆଲୋକ ଶ୍ଳେଷଣର ହାର ବୃ ଦ୍ଧି  ପାଇବ

✓

Q25 GA
ପରି ବହନ କ୍ଷେତ୍ର ରେ ମହି ଳାମାନଙ୍କୁ  ସଶକ୍ତ କରି ବା ତଥା ଚାରି -ଚକି ଆ ଟ୍ୟାକ୍ସି  ପାଇଁ  10 ଲକ୍ଷ
ଟଙ୍କା ପର୍ଯ୍ୟ ନ୍ତ ସୁ ଧ-ମୁ କ୍ତ ଋଣ ଯୋଗାଇଦେବା ଉଦ୍ଦେଶ୍ୟରେ ଓଡ଼ି ଶା ସରକାର 2025
ମସି ହାରେ କେଉଁ  କାର୍ଯ୍ୟ କ୍ର ମର ଶୁ ଭାରମ୍ଭ କରି ଥି ଲେ?

A.  ଆମ ସଖୀ ଟ୍ୟାକ୍ସି  ଯୋଜନା

B.  ଆମ ସୁ  ବାହକ କାର୍ଯ୍ୟ କ୍ର ମ

C.  ମହି ଳା ଟ୍ୟାକ୍ସି  ଉଦ୍ୟମ ଯୋଜନା

D.  ୱେମେନ ହ୍ୱି ଲସ (Wheels) ଓଡ଼ି ଶା ଇନି ସି ଏଟି ଭ

✓

Q26 GA
ସବ୍ୟସାଚୀ ମି ଶ୍ର ଙ୍କ ଅଭି ନୀତ ଓଡ଼ି ଆ ଚଳଚ୍ଚି ତ୍ର  'ପୁ ଷ୍କର' ଜାତୀୟ ଚଳଚ୍ଚି ତ୍ର  ପୁ ରସ୍କାର 2025
ରେ 'ଶ୍ରେ ଷ୍ଠ ଓଡ଼ି ଆ ଚଳଚ୍ଚି ତ୍ର ' ସମ୍ମାନ ଲାଭ କରି ଛି  । ଏହି  ପୁ ରସ୍କାର କେଉଁ  ବର୍ଷ ର
ଚଳଚ୍ଚି ତ୍ର ଗୁ ଡ଼ି କୁ  ଆଧାର କରି  ପ୍ର ଦାନ କରାଯାଇଥି ଲା?

A.  2022

B.  2023

C.  2024

D.  2025

✓

Q27 GA
ମାରି ଆ କରି ନା ମାଚାଡୋ (Maria Corina Machado) କେଉଁ  ଦେଶରେ ତାଙ୍କର
ଦୀର୍ଘ ଦି ନର କାର୍ଯ୍ୟ  ପାଇଁ  2025 ନୋବେଲ ଶାନ୍ତି  ପୁ ରସ୍କାର (Nobel Peace Prize) ରେ
ସମ୍ମାନି ତ ହୋଇଥି ଲେ?

A.  କଲମ୍ବି ଆ

B.  ଭେନି ଜୁ ଏଲା

C.  ବ୍ରା ଜି ଲ

D.  ଆର୍ଜେ ଣ୍ଟି ନା

✓

Q28 GA
କେଉଁ  ମସି ହାରେ ଆନ୍ତର୍ଜା ତୀୟ କୋଏଲି ସନ ଫର ଡି ଜାଷ୍ଟର ରି ଜି ଲି ଏଣ୍ଟ ଇନଫ୍ରା ଷ୍ଟ୍ରକ୍ଚର ବା
Coalition for Disaster Resilient Infrastructure (CDRI) ର ପ୍ର ତି ଷ୍ଠାକୁ
ଆନୁ ଷ୍ଠାନି କ ଭାବେ ଅନୁ ମୋଦନ କରାଯାଇଥି ଲା?

A.  2014

B.  2016

C.  2019

D.  2020

✓

Q29 GA
ସେପ୍ଟେମ୍ବର 2025 ରେ ଭାରତ କେଉଁ  ଦେଶରେ ଆତ୍ମନି ର୍ଭ ର ଭାରତ ଅଭି ଯାନ ଅଧୀନରେ
ଏହାର ପ୍ର ଥମ ଓଭରସି ଜ ଡି ଫେନ୍ସ  ମ୍ୟାନୁ ଫାକ୍ଚରି ଙ୍ଗ ଫାସି ଲି ଟି  ଉଦଘାଟନ କରି ଥି ଲା?

A.  ଆଲଜେରି ଆ

B.  ଟ୍ୟୁ ନି ସି ଆ

C.  ମୋରୋକ୍କୋ

D.  ଦକ୍ଷି ଣ ଆଫ୍ରି  କା

✓

Q30 GA
ଅଗଷ୍ଟ 2025 ରେ, ପ୍ର ଧାନମନ୍ତ୍ରୀ ନରେନ୍ଦ୍ର ମୋଦୀ କେଉଁ  ରାଜ୍ୟରେ 'ଅର୍ବା ନ ଏକ୍ସଟେନ୍ସ ନ୍
ରୋଡ୍ -II' (UER-II) ର ଉଦଘାଟନ କରି ଥି ଲେ?

A.  ଦି ଲ୍ଲୀ

B.  ଓଡ଼ି ଶା

C.  ଆନ୍ଧ୍ର ପ୍ର ଦେଶ

D.  ଝାଡଖଣ୍ଡ
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✓

Q31 GA
ହି ମବାହ ଜମା ହେବା ଦ୍ଵାରା କେଉଁ  ଭୂ ମି ରୂ ପ ସୃ ଷ୍ଟି  ହୋଇଥାଏ?

A.  ତ୍ରି  କୋଣଭୂ ମି

B.  ଗ୍ରା ବ (Moraine)

C.  କ୍ୟାନି ଅନ (Canyon)

D.  ମାଳଭୂ ମି

✓

Q32 GA
ନି ମ୍ନ ଲି ଖି ତ କେଉଁ ଟି  ଭାରତର ପ୍ର ଥମ ସମକାଳୀନ ଜନଗଣନା (synchronous Census)
କୁ  ସଠି କ ଭାବରେ ଚି ହ୍ନଟ କରେ?

A.  1901

B.  1881

C.  1865

D.  1872

✓

Q33 GA
ନି ମ୍ନ ଲି ଖି ତ କେଉଁ ଟି  ଧାତବ ଅକ୍ସାଇଡ ଏବଂ ଅମ୍ଳ  ମଧ୍ୟରେ ହେଉଥି ବା ରାସାୟନି କ ପ୍ର ତି କ୍ରି  ୟା
ସମ୍ବନ୍ଧରେ ଏକ ଭୁ ଲ ବି ବୃ ତି  ଅଟେ?

A.  ଅମ୍ଳ  ସହ ପ୍ର ତି କ୍ରି  ୟା ସମୟରେ ଧାତବ ଅକ୍ସାଇଡ କ୍ଷାର ଭଳି  କାର୍ଯ୍ୟ  କରେ

B.  ଧାତବ ଅକ୍ସାଇଡ ଅମ୍ଳ  ସହ ପ୍ର ତି କ୍ରି  ୟା କରି  ଅଙ୍ଗାରକାମ୍ଳ  ଗ୍ୟାସ ସୃ ଷ୍ଟି  କରେ

C.  ଧାତବ ଅକ୍ସାଇଡ ଏକ ପ୍ର ଶମନୀକରଣ ପ୍ର ତି କ୍ରି  ୟାରେ ଅମ୍ଳ  ସହ ମି ଶି ଥାଏ

D.  ଧାତବ ଅକ୍ସାଇଡ ଅମ୍ଳ କୁ  ପ୍ର ଶମି ତ କରି  ଲବଣ ଏବଂ ଜଳ ସୃ ଷ୍ଟି  କରେ

✓

Q34 GA
ଆଧୁ ନି କ ଓଡ଼ି ଶାରେ ଶାସ୍ତ୍ରୀୟ ନୃ ତ୍ୟ କଳା 'ଓଡ଼ି ଶୀ'ର ସାଂସ୍କୃତି କ ମହତ୍ତ୍ୱକୁ  ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ
କେଉଁ ଟି  ସର୍ବୋ ତ୍ତମ ଭାବରେ ବର୍ଣ୍ଣ ନା କରେ?

A.  ଏହା ମୋଗଲ ଶାସନ କାଳରେ ଏକ ରାଜକୀୟ ଦରବାର ନୃ ତ୍ୟ ଭାବରେ ଉତ୍ପନ୍ନ
ହୋଇଥି ଲା

B.  ଏହା ସ୍ୱାଧୀନତା ପରେ ପୁ ନରୁ ଦ୍ଧାର ହୋଇଥି ଲା ଏବଂ ପ୍ର ଭୁ  ଜଗନ୍ନାଥଙ୍କ ମନ୍ଦି ର
ପରମ୍ପରା ସହି ତ ନି ବି ଡ଼ ଭାବେ ଜଡ଼ି ତ ଅଟେ

C.  "ଏହା ମୁ ଖ୍ୟତଃ ଉତ୍ତର ଓଡ଼ି ଶାରେ ଏକ ଆଦି ବାସୀ ସମର ନୃ ତ୍ୟ ଭାବରେ ବି କଶି ତ
ହୋଇଥି ଲା

D.  ଏହା ଏକ ଆଧୁ ନି କ ନୃ ତ୍ୟ ଶୈ ଳୀ ଅଟେ, ଯାହାକି  କୌଣସି  ଐତି ହାସି କ ମୂ ଳଦୁ ଆ
ବି ନା 20ତମ ଶତାବ୍ଦୀରେ ସୃ ଷ୍ଟି  ହୋଇଥି ଲା

✓

Q35 GA
ଯଦି  ଏକ ସାଂସ୍କୃତି କ କାର୍ଯ୍ୟ କ୍ର ମରେ ସନ୍ତୁରର ଅନନ୍ୟ ଝଙ୍କାର ପ୍ର ଦର୍ଶ ନ କରି ବାକୁ  ଚାହାଁ ନ୍ତି ,
ତେବେ ଐତି ହାସି କ ସମ୍ପୃ କ୍ତି  ଆଧାରରେ 20 ତମ ଶତାବ୍ଦୀର କେଉଁ  କଳାକାରଙ୍କୁ  ଆମନ୍ତ୍ରଣ
କରି ବା ସବୁ ଠାରୁ  ଅଧି କ ଉପଯୁ କ୍ତ ହେବ?

A.  ଉସ୍ତାଦ ଅସଦ ଅଲୀ ଖାନ

B.  ପଣ୍ଡି ତ ଶି ବ କୁ ମାର ଶର୍ମା

C.  ଜାକି ର ହୁ ସେନ

D.  ଉସ୍ତାଦ ଅମଜଦ ଅଲୀ ଖାନ

✓

Q36 GA
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କି ଏ ଦ ଗାଇଡ (The Guide) ପୁ ସ୍ତକର ଲେଖକ ଅଟନ୍ତି ?

A.  ମୁ ଲ୍କ ରାଜ ଆନନ୍ଦ  

B.  ଆର. କେ. ନାରାୟଣ

C.  ରାଜା ରାଓ

D.  ଖୁ ସୱନ୍ତ ସିଂ

✓

Q37 GA
କେଉଁ  ଭୂ ମି ରୂ ପ ଥର ମରୁ ଭୂ ମି ରେ ସବୁ ଠାରୁ  ଅଧି କ ଦେଖାଯାଏ?

A.  ମୋରେନ୍ସ  (Moraines)

B.  ବାଲି  ପାହାଡ଼ (Sand dunes)

C.  V-ଆକୃ ତି ର ଉପତ୍ୟକା

D.  ଲାଭା ମାଳଭୂ ମି

✓

Q38 GA
ବର୍ତ୍ତ ମାନ ଭାରତୀୟ ସମ୍ବି ଧାନରେ ଉଲ୍ଲେଖ ଥି ବା ନି ମ୍ନ ଲି ଖି ତ ଅଧି କାରଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  କେଉଁ ଟି
ଏକ ମୌଳି କ ଅଧି କାର ନୁ ହେଁ ?

A.  ସମାନତା ଅଧି କାର

B.  ସମ୍ପତ୍ତି ଗତ ଅଧି କାର

C.  ଶୋଷଣ ବି ରୋଧି  ଅଧି କାର

D.  ଧାର୍ମିକ ସ୍ୱାଧୀନତା ଅଧି କାର

✓

Q39 GA
ବ୍ରି  ଟି ଶ ଶାସନ ବି ରୁ ଦ୍ଧରେ ମୁ ଣ୍ଡା ବି ଦ୍ରୋ ହ (1899-1900) ର ନେତା କି ଏ ଥି ଲେ?

A.  ସି ଧୁ  ମୁ ର୍ମୁ

B.  ବି ର୍ସା  ମୁ ଣ୍ଡା

C.  ତି ଲକା ମାଂଝି

D.  ତାନା ଭଗତ

✓

Q40 GA
ମଇ 2025 ରେ ପ୍ର କାଶି ତ ମାନବ ବି କାଶ ରି ପୋର୍ଟ  2025 ଅନୁ ଯାୟୀ ମାନବ ବି କାଶ
ସୂ ଚକାଙ୍କ (HDI) ରେ ଭାରତର ସ୍ଥାନ କେତେ ଅଟେ?

A.  ଏକ ଶହ ତି ରି ଶ

B.  ଏକ ଶହ କୋଡି ଏ

C.  ଏକ ଶହ ପଚାଶ

D.  ଏକ ଶହ ଦଶ
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English

✓

Q41 English
Complete the sentence by filling in the blank with the correct option.

Ajay practiced ____ to win the badminton championship and surprised everyone by defeating the reigning champion.

A.  hardly

B.  hard

C.  hardest

D.  harder

✓

Q42 English
Select the most appropriate proverb that can substitute the highlighted segment in the given sentence.

The minister was arrested for fraud, which proves that your actions determine your future outcomes.

A.  where there is smoke, there is fire

B.  necessity is the mother of invention

C.  you reap what you sow

D.  crime does not pay

✓

Q43 English
Select the option that can be used as a one-word substitute for the underlined group of words.

The speaker stepped onto the stage and addressed the solemn assembly of hearers that had gathered to hear this testimony.

A.  brigand

B.  deponent

C.  assemblage

D.  gynecologist

✓

Q44 English
Select the option that can be used as a one-word substitute for the highlighted segment in the given sentence.

Because it was considered an entry made without permission of privacy, the hotel owner was arrested for installing cameras in the rooms.

A.  entrant

B.  intrusion

C.  expulsion

D.  attainment
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✓

Q45 English
Parts of a sentence are given below in jumbled order. Arrange the parts in the correct order to form a meaningful sentence.

(P) while many butterfly species showed population declines
(Q) skipper, cryptic wood white and chalk hill blue seeing
(R) sharp drops compared to the previous year
(S) last year, nine suffered their worst year on record - with the grizzled

A.  PSQR

B.  PSRQ

C.  PRQS

D.  QSPR

✓

Q46 English
Read the sentence carefully and choose the correct future tense verb form to complete it meaningfully.

By this time next month, the team ________ data from the newly discovered cave system.

A.  has collected

B.  will collects

C.  will collected

D.  will have collected

✓

Q47 English
In the following question, a statement has been given in brackets. You are required to replace the statement with the correct idiom given in the
options.
During the meeting, Arjun refused to admit his mistake. He (ignored the problem intentionally) and avoided responsibility.

A.  Drew the line

B.  Spoke his mind

C.  Turned a blind eye

D.  Lost track of time

✓

Q48 English

Read the passage and answer the questions that follow.

Trees are vital to life on Earth. They produce oxygen, absorb carbon dioxide, and prevent soil erosion. Forests provide habitats for countless
species of animals and plants, maintaining ecological balance. Trees also offer fruits, timber, and shade. In cities, they reduce pollution, lower
temperatures, and improve mental health. However, deforestation has become a major problem due to urbanization, logging, and agriculture.
Large-scale tree cutting causes loss of biodiversity, climate changes, and natural disasters like floods. Protecting existing forests and planting
new trees are essential to ensure a sustainable environment. Every individual’s effort to plant and care for trees contributes to a healthier planet
for future generations.

According to the passage, what do trees absorb from the atmosphere?

A.  Oxygen

B.  Nitrogen

C.  Carbon dioxide

D.  Methane
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✓

Q49 English
What is the main theme of the passage?

A.  The economic value of timber and fruits

B.  The importance of trees and the need to prevent deforestation

C.  The process of photosynthesis in plants

D.  The cultural uses of trees in different countries

✓

Q50 English
Which of the following titles best suits the passage?

A.  The Economic Value of Forests

B.  The Wonders of Photosynthesis

C.  Trees: Nature’s Protectors

D.  Life in the Urban Jungle

✓

Q51 English
Which statement best describes the structure of the passage?

A.  It describes the benefits of trees, discusses problems caused by deforestation, and ends with a solution for sustainability.

B.  It compares trees with other plants and describes their anatomy.

C.  It narrates a story about planting trees in a city.

D.  It lists random facts about forests without conclusion.

✓

Q52 English
Choose the antonym of the word “sustainable” as used in the passage.

A.  Balanced

B.  Durable

C.  Temporary

D.  Continuous

✓

Q53 English
Select the most appropriate antonym of the underlined word in the given sentence.

The abundant rainfall led to a good harvest that year.

A.  Plentiful

B.  Scarce

C.  Efficient

D.  Medium
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✓

Q54 English
Choose the correct option to complete the indirect speech sentence.

The guide explained that the sculpture ______ during the late medieval period.

A.  was created

B.  is created

C.  has been created

D.  will be created

✓

Q55 English
Arrange the following to create a logical, grammatically correct sentence.

(1) after he had studied
(2) for the exam
(3) John felt confident
(4) for several weeks

A.  After he had studied John felt confident for several weeks for the exam.

B.  John felt confident for the exam after he had studied for several weeks.

C.  For several weeks after he had studied John felt confident for the exam.

D.  For the exam John felt confident after he had studied for several weeks.

✓

Q56 English
Identify the antonym of intricate in the following sentence.
The marooned survivors improvised a rudimentary shelter from flotsam to mitigate the effects of the torrential rain.

A.  marooned

B.  improvised

C.  rudimentary

D.  torrential

✓

Q57 English
Select the INCORRECTLY spelt word.
They were to be dragged through the publicity, the humeliations, that precede the sundering of what God has joined together.

A.  dragged

B.  publicity

C.  humeliations

D.  precede

✓

Q58 English
Select the most suitable option to complete the sentence.
She answered all the questions ________, showing a deep understanding of the subject matter.

A.  forcibly

B.  thoroughly

C.  roughly

D.  timidly
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✓

Q59 English
Select the most appropriate option to fill in the blanks.
She liked ____ dress displayed in ____ shop of the designer boutique she had visited earlier.

A.  a; a

B.  a; an

C.  an; a

D.  the; the

✓

Q60 English
Select the option that expresses the given sentence in passive voice.

Ananya completed the homework.

A.  The homework is completed by Ananya.

B.  The homework was completed by Ananya.

C.  The homework has been completed by Ananya.

D.  The homework will be completed by Ananya.

Odia

✓

Q61 Odia
ବି ଶେଷଣ ପଦ ବ୍ୟବହାର କରି  ବାକ୍ୟଟି କୁ  ସମ୍ପୂ ର୍ଣ୍ଣ  କର ।

'' ସମ୍ବାଦପତ୍ର  ହେଉଛି  ଗଣତନ୍ତ୍ରର ____ ସ୍ତମ୍ଭ ।''

A.  ପଞ୍ଚମ

B.  ଷଷ୍ଠ

C.  ସପ୍ତମ

D.  ଚତୁ ର୍ଥ

✓

Q62 Odia
ନି ମ୍ନ ଲି ଖି ତ ଶବ୍ଦଗୁ ଡ଼ି କର ବି ପରୀତ ଶବ୍ଦ ଲେଖନ୍ତୁ
ଫୁ ଲଗୁ ଡ଼ି କ ବହୁ ତ "ସୁ ନ୍ଦର" ଅଟନ୍ତି ।

A.  ଖରାପ

B.  ଦୀର୍ଘ

C.  ଗରି ବ

D.  ନୂ ତନ

✓

Q63 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ଇସ୍ରୋ  ଭାରତର ମହାକାଶୀୟ ଅନୁ ସନ୍ଧାନ ସଂସ୍ଥା ଅଟେ ।

A.  ISRO is India’s space research organization.

B.  ISRO is an American company.

C.  ISRO controls Indian railways.

D.  ISRO is a weather forecasting agency.
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✓

Q64 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ଚନ୍ଦ୍ରଗୁ ପ୍ତ ମୌର୍ଯ୍ୟ  ମୌର୍ଯ୍ୟ  ସାମ୍ରା ଜ୍ୟର ପ୍ର ତି ଷ୍ଠାତା ଥି ଲେ ।

A.  Chandragupta Maurya was the founder of the Mauryan Empire.

B.  Chandragupta Maurya were founder for Mauryan empire.

C.  The Chandragupta is founding Mauryan Empire.

D.  Chandragupta Maurya be the found of Empire.

✓

Q65 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କରୁ  ଦି ଆଯାଇଥି ବା ଇଂରାଜୀ ବାକ୍ୟଟି ର ସଠି କ୍  ଓଡ଼ି ଆ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
Deforestation leads to soil erosion and loss of wildlife habitat.

A.  ନି ର୍ବ ନୀକରଣ କାରଣରୁ  ମୃ ତ୍ତି କା କ୍ଷୟ ଏବଂ ବନ୍ୟଜୀବନସ୍ଥଳୀ କ୍ଷୟ ହୋଇଯାଏ।

B.  ବନକାଟ ମାଟି  ଭାସି  ଏବଂ ପ୍ରା ଣୀ ଆବାସ ହାନି  ଘଟି ଲା।

C.  ବନକାଟ ମାଟି କୁ  ଭାସାଇ ଏବଂ ପ୍ରା ଣୀ ଆବାସ ହାନି  ହେଲା।

D.  ବନକାଟ ମାଟି  ଭାସାଇ ଏବଂ ପ୍ରା ଣୀ ଆବାସ ହାନି  ହୁ ଏ।

✓

Q66 Odia
ନି ମ୍ନ ରେ ଦି ଆଯାଇଥି ବା ବି କଳ୍ପ ମଧ୍ୟରୁ  ଉପଯୁ କ୍ତ ସମାନାର୍ଥ କ ଶବ୍ଦ ଚୟନ କରନ୍ତୁ ।
ଆନନ୍ଦ

A.  ପ୍ର ଫୁ ଲ୍ଲ

B.  ବି ଷାଦ

C.  ନୃ ତ୍ୟ

D.  ସଙ୍ଗୀତ
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✓

Q67 Odia

ନି ମ୍ନ ଲି ଖି ତ ଅନୁ ଚ୍ଛେଦର ବି ଷୟବସ୍ତୁକୁ  ଭଲଭାବରେ ପଢ । ତା ତଳେ ପ୍ର ଦତ୍ତ ପ୍ର ତ୍ୟେକ ପ୍ର ଶ୍ନ ର ଚାରି ଟି  ସମ୍ଭାବି ତ ଉତ୍ତର ମଧ୍ୟରୁ  ସଠି କ ଉତ୍ତରକୁ  ଚୟନ କରନ୍ତୁ |

ଭାରତୀୟ ସି ନେମାର ସବୁ ଠାରୁ  ପ୍ରି  ୟ ହାସ୍ୟ ଅଭି ନେତା ଗୋବର୍ଦ୍ଧ ନ ଆସରାନି , ଆସରାନି  ନାମରେ ବେଶ ଲୋକପ୍ରି  ୟ ଅର୍ଜ ନ କରି ଥି ଲେ । ସେ ଜାନୁ ଆରୀ 1, 1941 ରେ ରାଜସ୍ଥାନର ଜୟପୁ ରରେ
ଜନ୍ମ ଗ୍ର ହଣ କରି ଥି ଲେ | ଦୀର୍ଘ  ଦଶନ୍ଧି  ଧରି  ହାସ୍ୟ ଭୂ ମି କା କୁ  ନି ଖୁ ଣ ଭାବେ ନି ଭାଇ ଦର୍ଶ କଙ୍କୁ  ହସାଇବାର ତାଙ୍କର ଅନନ୍ୟ କ୍ଷମତା ମାଧ୍ୟମରେ ସେ ଘରେ ଘରେ ପରି ଚି ତ ହୋଇଥି ଲେ।

ଚଳଚ୍ଚି ତ୍ର  ଜଗତରେ ପାଦ ଦେବା ଲାଗି  ସେ ପୁ ଣେର ଫି ଲ୍ମ ଆଣ୍ଡ ଟେଲି ଭି ଜନ ଇନଷ୍ଟି ଚ୍ୟୁ ଟ୍  ଅଫ୍  ଇଣ୍ଡି ଆ (FTII) ରେ ଅଭି ନୟରେ ତାଲି ମ ନେଇଥି ଲେ। ତାଙ୍କର ପ୍ର ଥମ ପ୍ର ଦର୍ଶ ନ 1960 ଦଶକର ଶେଷ
ଭାଗରେ ହୋଇଥି ଲା, କି ନ୍ତୁ 1970 ଦଶକରେ ସେ ଷ୍ଟାରଡମ ହାସଲ କରି ଥି ଲେ । ହୃ ଷୀକେଶ ମୁ ଖାର୍ଜୀ  ଏବଂ ରାଜ କପୁ ରଙ୍କ ପରି  ପ୍ର ସି ଦ୍ଧ ନି ର୍ଦ୍ଦେ ଶକଙ୍କ ସହ କାମ କରି ବାରୁ  ତାଙ୍କୁ  ଅନେକ ପ୍ର କାରର
ହାସ୍ୟରସ ଅଭି ନୟର ପ୍ର ଦର୍ଶ ନ କରି ବାରେ ସାହାଯ୍ୟ ମି ଳି ଥି ଲା ।

1975 ମସି ହାର ବ୍ଲ କବଷ୍ଟର ଫି ଲ୍ମ "ଶୋଲେ"ରେ ଆସରାନି ଙ୍କ ସବୁ ଠାରୁ  ପ୍ର ସି ଦ୍ଧ ଭୂ ମି କା ଥି ଲା, ଯେଉଁ ଠାରେ ସେ ବ୍ରି  ଟି ଶ ଅଧି କାରୀମାନଙ୍କୁ  ବ୍ୟଙ୍ଗ କରି  ଏକ ଅଦ୍ଭୁ ତ ଜେଲର ଭୂ ମି କାରେ ଅଭି ନୟ
କରି ଥି ଲେ। ତାଙ୍କର ପ୍ର ସି ଦ୍ଧ ପଂକ୍ତି  - "ହମ୍  ଅଙ୍ଗରେଜୋଁ  କେ ଜମାନେ କେ ଜେଲର୍  ହେ!" - ଲୋକପ୍ରି  ୟ ସଂସ୍କୃତି ରେ ସ୍ଥାନି ତ ହୋଇ ରହି ଛି  । ଏହି  ଭୂ ମି କା ତାଙ୍କର ବ୍ୟଙ୍ଗ ପ୍ର ତି ଭାକୁ  ପ୍ର ଦର୍ଶ ନ କରି ଥି ଲା,
ଏବଂ ଆଜି  ମଧ୍ୟ ଦର୍ଶ କମାନେ ସେହି  ସଂକ୍ଷି ପ୍ତ କି ନ୍ତୁ ଅବି ସ୍ମରଣୀୟ ଅଭି ନୟକୁ  ଭାରତୀୟ ସି ନେମାର ସବୁ ଠାରୁ  ମଜାଦାର ମୁ ହୂ ର୍ତ୍ତ  ଭାବରେ ମନେ ରଖନ୍ତି । ଆସରାନି  350 ରୁ  ଅଧି କ ଫି ଲ୍ମରେ ଅଭି ନୟ
କରି ଥି ଲେ, । ସେ ରାଜେଶ ଖାନ୍ନା, ଅମି ତାଭ ବଚ୍ଚନ ଏବଂ ସଲମାନ ଖାନଙ୍କ ପରି  ତାରକାଙ୍କ ସହି ତ ଅଭି ନୟ କରି ଥି ଲେ, ଓ ତାଙ୍କ ବହୁ ମୁ ଖୀ ପ୍ର ତି ଭା ପାଇଁ  ସେ ପ୍ର ଶଂସା ଅର୍ଜ ନ କରି ଥି ଲେ। କମେଡି
ବ୍ୟତୀତ, ଆସରାନି  ଗମ୍ଭୀର ଭୂ ମି କାରେ ମଧ୍ୟ ନି ଜର ଦକ୍ଷତା ପ୍ର ମାଣି ତ କରି ଥି ଲେ ଏବଂ ନି ର୍ଦ୍ଦେ ଶନା କ୍ଷେତ୍ର ରେ ମଧ୍ୟ କାର୍ଯ୍ୟ  କରି ଥି ଲେ।

ଆହୁ ରି  ମଧ୍ୟ ଆସରାନି  ଟେଲି ଭି ଜନ ଧାରାବାହି କ ଏବଂ ଆଧୁ ନି କ ହି ନ୍ଦୀ ଚଳଚ୍ଚି ତ୍ର  ଗୁ ଡ଼ି କରେ ଦର୍ଶ କଙ୍କୁ  ଆକର୍ଷିତ କରି ଥି ଲେ,। ଭାରତୀୟ ସି ନେମାରେ ତାଙ୍କର ଅବଦାନ ହସଠାରୁ  ଅଧି କ - ସେ ଚରି ତ୍ର
ଅଭି ନେତା ମାନଙ୍କ ପାଇଁ  ଏକ ମାନଦଣ୍ଡ ସ୍ଥାପନ କରି ଥି ଲେ ଏବଂ ଆଗାମୀ ପି ଢ଼ି ର ହାସ୍ୟ ଅଭି ନେତାଙ୍କୁ  ପ୍ରେ ରଣା ଦେଇଥି ଲେ। ଆସରାନି ଙ୍କ ହାସ୍ୟରସ କୁ  ଭାବନା ସହି ତ ମି ଶ୍ର ଣ କରି ବାର ତାଙ୍କର ଦକ୍ଷତା
ତାଙ୍କୁ  ଅନ୍ୟ ହାସ୍ୟ ଅଭି ନେତା ଙ୍କ ଠୁ  ସ୍ଵତନ୍ତ୍ର କରି ଥାଏ । 84 ବର୍ଷ  ବୟସରେ 20 ଅକ୍ଟୋବର 2025 ରେ ସେ ପରଲୋକ ଗମନ କରି ଛନ୍ତି  |

ଅସରାନୀ କେଉଁ ଠାରେ ଜନ୍ମ  ଗ୍ର ହଣ କରି ଥି ଲେ?

A.  ମୁ ମ୍ବାଇ

B.  ଜୟପୁ ର

C.  ଦି ଲ୍ଲୀ

D.  ପୁ ଣେ

✓

Q68 Odia
କେଉଁ  ଚଳଚ୍ଚି ତ୍ର ରେ ଆସରାନୀ ଜଣେ ବ୍ୟଙ୍ଗାତ୍ମକ ଜେଲର ଭୂ ମି କାରେ ଅଭି ନୟ କରି ଥି ଲେ?

A.  ଚୁ ପକେ ଚୁ ପକେ

B.  ଗୋଲମାଲ୍

C.  ଶୋଲେ

D.  ଅମର ଆକବର ଆନ୍ଥୋନି

✓

Q69 Odia
କେବେ ଆସରାନୀଙ୍କ ପରଲୋକ ଘଟି ଥି ଲା ?

A.  25 ଅକ୍ଟୋବର 2025

B.  20 ଅକ୍ଟୋବର 2025

C.  27 ଅକ୍ଟୋବର 2025

D.  22 ଅକ୍ଟୋବର 2025

✓

Q70 Odia
ଆସରାନୀ ପ୍ରା ୟ କେତେ ଚଳଚ୍ଚି ତ୍ର ରେ ଅଭି ନୟ କରି ଛନ୍ତି ?

A.  100

B.  200

C.  350

D.  500
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✓

Q71 Odia
ଅନ୍ୟ ହାସ୍ୟ ଅଭି ନେତାଙ୍କ ମଧ୍ୟରେ ଆସରାନୀଙ୍କୁ  କେଉଁ  ଗୁ ଣ ସ୍ୱତନ୍ତ୍ର କରି ଥି ଲା?

A.  ତାଙ୍କର ଗମ୍ଭୀର ସ୍ୱର

B.  ହାସ୍ୟରସକୁ  ଭାବନା ସହି ତ ମି ଶ୍ର ଣ କରି ବାର ତାଙ୍କର କ୍ଷମତା

C.  ତାଙ୍କର ନୃ ତ୍ୟ ଦକ୍ଷତା

D.  ତାଙ୍କର ଖଳନାୟକ ଭୂ ମି କା

✓

Q72 Odia
"ଖାଇବା" କେଉଁ  ପ୍ର କାରର ପଦ?

A.  କ୍ରି  ୟାବାଚକ ବି ଶେଷ୍ୟ

B.  ସମାପି କା କ୍ରି  ୟା

C.  ବି ଶେଷଣ

D.  ଅସମାପି କା କ୍ରି  ୟା

✓

Q73 Odia
‘ଦଫାରଫା କରି ବା’ ରୂ ଢି ର ଅର୍ଥ  ଚି ହ୍ନଟ କର ।

A.  ମକଦମା ଫଇସଲା କରି ବା

B.  ଜୀବି କା ବୁ ଡ଼ାଇବା

C.  ଦୋଷ ମାନି ବା

D.  ସମସ୍ତ ଖ୍ୟାତି  ହରାଇବା

✓

Q74 Odia
ବି ଲେଇଟି  କ୍ଷୀର ------------- । ଶୂ ନ୍ୟସ୍ଥାନ ପୂ ରଣ କର ।

A.  ଗୀତ

B.  ମାଛ

C.  ପି ଉଛି

D.  ଆସି ଛି

✓

Q75 Odia
ଠି କ୍  ଶବ୍ଦଟି  ଚି ହ୍ନାଇ ଦି ଅ?

A.  ମନ୍ତ୍ରୀମନଲ

B.  ମନ୍ତ୍ରି ମଣ୍ଡଳ

C.  ମନ୍ତ୍ରୀ ମଣ୍ଡଳ

D.  ମନ୍ତ୍ରୀର୍ମ ଣ୍ଡଳ
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Computer

✓

Q76 Computer
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  MS ପାୱାରପଏଣ୍ଟ 2021 ରେ ଟେମ୍ପଲେଟ କୁ  ବ୍ୟାଖ୍ୟା କରେ?

A.  ଏକ ବ୍ଳା ଙ୍କ ସ୍ଲା ଇଡ

B.  ଏକ ପୂ ର୍ବ ରୁ -ଡି ଜାଇନ ହୋଇଥି ବା ଲେଆଉଟ

C.  ଏକ ସାଉଣ୍ଡ ଇଫେକ୍ଟ

D.  ଏକ ଭି ଡି ଓ ଟ୍ରା ଞ୍ଜି ସନ

✓

Q77 Computer
MS-ପାୱାରପଏଣ୍ଟରେ "Save" ଅପସନଟି  କେଉଁ ଠାରେ ଅଛି ?

A.  Home ଟ୍ୟାବରେ

B.  File ଟ୍ୟାବରେ (Backstage view)

C.  Insert ଟ୍ୟାବରେ

D.  View ଟ୍ୟାବରେ

✓

Q78 Computer
ପାୱାରପଏଣ୍ଟରେ ଆପଣ ଡି ଫଲ୍ଟ  ଫାଇଲ ଫର୍ମା ଟ ପରି ବର୍ତ୍ତ ନ କରି ବାକୁ  ଚାହୁଁ ଛନ୍ତି
ଯେଉଁ ଥି ରେ ପ୍ରେ ଜେଣ୍ଟେସନଗୁ ଡ଼ି କ ସେଭ ହୋଇଥାଏ (ଉଦାହରଣ, .odp କି ମ୍ବା ଅନ୍ୟାନ୍ୟ)।
କେଉଁ  ସେଟିଂ  ଏହା କରି ବା ପାଇଁ  ଅନୁ ମତି  ଦି ଏ?

A.  File → Export → Create Video

B.  File → Options → Save → “Save files in this format”

C.  Insert → Media → Video

D.  Review → Protect → Format

✓

Q79 Computer
MS ଏକ୍ସେଲ 2021 ରେ ଡାଟା ସର୍ଟିଂ କରି ବା ପରି ପ୍ରେ କ୍ଷୀରେ, ସ୍ତମ୍ଭ A ରେ ଥି ବା
କମାଣ୍ଡଗୁ ଡ଼ି କୁ  ସ୍ତମ୍ଭ B ରେ ଥି ବା ବ୍ୟାଖ୍ୟା ସହି ତ ମେଳ କରନ୍ତୁ :

ସ୍ତମ୍ଭ A – ସର୍ଟିଂ କମାଣ୍ଡ ସ୍ତମ୍ଭ B – ବ୍ୟାଖ୍ୟା

1. ସର୍ଟ  A → Z a) ଟେକ୍ସଟ ମୂ ଲ୍ୟଗୁ ଡ଼ି କୁ  ଡି ସେଣ୍ଡିଂ  ବର୍ଣ୍ଣା ନୁ କ୍ର ମରେ ସଜାଏ

2. ସର୍ଟ  Z → A b) ଟେକ୍ସଟ ମୂ ଲ୍ୟଗୁ ଡ଼ି କୁ  ଆସେଣ୍ଡିଂ  ବର୍ଣ୍ଣା ନୁ କ୍ର ମରେ ସଜାଏ

3. ଛୋଟରୁ  ବଡ଼ ଭାବେ
ସର୍ଟ  କରେ

c) ନ୍ୟୁ ମେରି କ ଡାଟାକୁ  ସର୍ବ ନି ମ୍ନ  ମୂ ଲ୍ୟରୁ  ସର୍ବୋ ଚ୍ଚ ମୂ ଲ୍ୟ
ପର୍ଯ୍ୟ ନ୍ତ ସର୍ଟ  କରେ

4. ବଡ଼ରୁ  ଛୋଟ ସର୍ଟ  କରେ
d) ନ୍ୟୁ ମେରି କ ଡାଟାକୁ  ସର୍ବୋ ଚ୍ଚ ମୂ ଲ୍ୟରୁ  ସର୍ବ ନି ମ୍ନ  ମୂ ଲ୍ୟ
ପର୍ଯ୍ୟ ନ୍ତ ସର୍ଟ  କରେ

A.  1–a, 2–b, 3–d, 4–c

B.  1–b, 2–a, 3–c, 4–d

C.  1–a, 2–b, 3–c, 4–d

D.  1–c, 2–d, 3–a, 4–b

✓

Q80 Computer
କ୍ୟାସେ ମେମୋରୀ (Cache memory) କେଉଁ  ଦୁ ଇଟି  କମ୍ପୋନେଣ୍ଟ ମଧ୍ୟରେ ଅବସ୍ଥି ତ?

A.  CPU ଏବଂ ହାର୍ଡ  ଡି ସ୍କ

B.  RAM ଏବଂ ROM

C.  CPU ଏବଂ RAM 

D.  କୀବୋର୍ଡ  ଏବଂ CPU

✓

Q81 Computer
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ଏକ ଆଉଟପୁ ଟ୍  ଡି ଭାଇସର ଉଦାହରଣ ଅଟେ?

A.  କି ବୋର୍ଡ

B.  ସ୍କାନର

C.  ମନି ଟର

D.  ବାରକୋଡ ରି ଡର

✓

Q82 Computer
ରୋବୋଟି କ୍ସ, ଅଟୋମେଟେଡ ଆସେମ୍ବଲି  ଲାଇନ ଏବଂ କମ୍ପ୍ୟୁ ଟର-କଣ୍ଟ୍ରୋଲଡ ମେସି ନ,
କମ୍ପ୍ୟୁ ଟର ଆପ୍ଲି  କେସନ କେଉଁ  କ୍ଷେତ୍ର ର ଉଦାହରଣ ଅଟେ ?

A.  ମେଡି କାଲ ରୋଗ ନି ର୍ଣ୍ଣ ୟ

B.  ଉତ୍ପାଦନ ଶି ଳ୍ପ

C.  ସ୍କୁଲ ଏବଂ କଲେଜ

D.  ପାଣି ପାଗ ପୂ ର୍ବା ନୁ ମାନ

✓

Q83 Computer
ଯେତେବେଳେ ଆପଣ MS ୱାର୍ଡ ରେ ଟେକ୍ସଟ ସି ଲେକ୍ଟ କରନ୍ତି  ଏବଂ Ctrl+Shift+V ପ୍ରେ ସ
କରନ୍ତି , ସେତେବେଳେ କେଉଁ  କାର୍ଯ୍ୟ  ସମ୍ପାଦି ତ ହୁ ଏ?

A.  କ୍ଲି  ପବୋର୍ଡ ରୁ  କପି  ହୋଇଥି ବା କଣ୍ଟେଣ୍ଟ ପେଷ୍ଟ ହୁ ଏ (Paste the copied
content from the clipboard)

B.  କପି  ହୋଇଥି ବା କଣ୍ଟେଣ୍ଟ ପେଷ୍ଟ ହୁ ଏ ଏବଂ ଡେଷ୍ଟି ନେସନର ଫର୍ମା ଟିଂ  ସହ ମେଳ
ହୁ ଏ (Paste the copied content and match the formatting of the
destination)

C.  କପି  ହୋଇଥି ବା କଣ୍ଟେଣ୍ଟ ପେଷ୍ଟ ହୁ ଏ ଏବଂ ଏହାର ମୂ ଳ ଫର୍ମା ଟିଂ  ସଂରକ୍ଷଣ ହୁ ଏ
(Paste the copied content and preserve its original formatting)

D.  କ୍ଲି  ପବୋର୍ଡ ରୁ  କେବଳ ପ୍ଳେନ ଟେକ୍ସଟ ପେଷ୍ଟ ହୁ ଏ (Paste only plain text
from the clipboard)

✓

Q84 Computer
ଗୋଟି ଏ ଇ-ମେଲ ଆକାଉଣ୍ଟରେ ଇନବକ୍ସ ର ଉଦ୍ଦେଶ୍ୟ କ’ଣ?

A.  ସେଣ୍ଟ ହୋଇଥି ବା ଇମେଲଗୁ ଡି କୁ  ଷ୍ଟୋର କରି ବା ପାଇଁ  ।

B.  ସେଣ୍ଟ ହେବାକୁ  ଥି ବା ଇମେଲଗୁ ଡି କୁ  ଷ୍ଟୋର କରି ବା ପାଇଁ  ।

C.  ଅନ୍ୟମାନଙ୍କ ଠାରୁ  ରି ସି ଭ ହୋଇଥି ବା ଇମେଲଗୁ ଡି କୁ  ଷ୍ଟୋର କରି ବା ପାଇଁ  ।

D.  ଡି ଲି ଟ ହୋଇଥି ବା ଇମେଲଗୁ ଡି କୁ  ଷ୍ଟୋର କରି ବା ପାଇଁ  ।
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✓

Q85 Computer
ଯଦି  ଆପଣ ଏକ ବଡ଼ ଡାଟା ସେଟରେ ପ୍ର ତ୍ୟେକ କଲମକୁ  ଚୟନ ନ କରି  ଗୋଟି ଏ କଲମକୁ
ସର୍ଟ  କରନ୍ତି , ତେବେ କ'ଣ ହେବ?

A.  ଏକ୍ସେଲ ଏକ ପାସୱାର୍ଡ଼  ମାଗି ବ

B.  କେବଳ ସେହି  କଲମ ବଦଳି ଥାଏ ଏବଂ ଡାଟା ମି ସମ୍ୟାଚ ହୋଇଯାଏ

C.  A1 ଏବଂ A5 ମଧ୍ୟରେ ଅନ୍ତର

D.  A1 ରୁ  A5 ପର୍ଯ୍ୟ ନ୍ତର ଗୁ ଣଫଳ

✓

Q86 Computer
କେଉଁ  ଡି ଭାଇସ ମୁ ଖ୍ୟତଃ ଡାଟାକୁ  ହାର୍ଡ  କପି  ଡକ୍ୟୁ ମେଣ୍ଟ ଭାବରେ ଆଉଟପୁ ଟ ଦେବା ପାଇଁ
ବ୍ୟବହୃ ତ ହୁ ଏ?

A.  ମାଉସ

B.  ପ୍ରି  ଣ୍ଟର

C.  ସ୍କାନର

D.  ସ୍ପି କର

✓

Q87 Computer
ଭର୍ଚୁ ଆଲ ମି ଟି ଙ୍ଗ ଏବଂ ସ୍କ୍ରି ନ ସେୟାରି ଙ୍ଗ ପାଇଁ  ସାଧାରଣତଃ କେଉଁ  ଟୁ ଲ ବ୍ୟବହାର
କରାଯାଏ?

A.  ଇନଷ୍ଟାଗ୍ରା ମ

B.  ହ୍ଵାଟସଆପ

C.  ବ୍ଲ ଗର

D.  ଜୁ ମ

✓

Q88 Computer
ଜଣେ ଫାଇନାନ୍ସି  ଆଲ ଆନାଲି ଷ୍ଟ ହି ସାବ କରାଯାଇଥି ବା ଟାକ୍ସ ଭାଲ୍ୟୁ  ର ଏକ କଲମ
(column) କପି  କରନ୍ତି  ଏବଂ ଆକ୍ସି ଡେଣ୍ଟାଲ ଫର୍ମୁ ଲା ଟ୍ୟାମ୍ପରି ଙ୍ଗ ପ୍ରି  ଭେଣ୍ଟ କରି ବା ପାଇଁ  ଏକ
ସମରୀ ସି ଟ (summary sheet) ରେ କେବଳ ଅନ୍ତି ମ ନ୍ୟୁ ମେରି କ ରେଜଲ୍ଟ  ପେଷ୍ଟ କରି ବା
ପାଇଁ  ଆବଶ୍ୟକ କରନ୍ତି  । ସେ କେଉଁ  ଏକ୍ସେଲ ସର୍ଟ କଟ ବ୍ୟବହାର କରି  କେବଳ ଭାଲ୍ୟୁ  ପେଷ୍ଟ
କରି ବେ?

A.  Alt + V + S + V

B.  Alt + S + E + V

C.  Alt + E + S + V

D.  Alt + E + S + R

✓

Q89 Computer
MS ୱାର୍ଡ ର ଏକ ପାରାଗ୍ରା ଫରେ ଟେକ୍ସଟକୁ  ଜଷ୍ଟି ଫାଏ କରି ବା ପାଇଁ  କେଉଁ  କୀବୋର୍ଡ  ସର୍ଟ କଟ୍
ବ୍ୟବହାର କରାଯାଏ?

A.  Ctrl + J

B.  Ctrl + L

C.  Ctrl + E

D.  Ctrl + R

✓

Q90 Computer
MS-ୱାର୍ଡ  ଟେମ୍ପଲେଟ ଫାଇଲ ପାଇଁ  ବ୍ୟବହୃ ତ ଏକ୍ସଟେନସନ ଚୟନ କର ।

A.  .dotx

B.  .dotm

C.  .doc

D.  .docx
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Reasoning

✓

Q91 Reasoning
P, Q, R, S, T, U ଏବଂ V ଏକ ବୃ ତ୍ତାକାର ଟେବୁ ଲ ଚାରି ପାଖେ କେନ୍ଦ୍ରକୁ  ମୁ ହଁ  କରି  ବସି ଛନ୍ତି  ।
U ର ବାମ ପଟକୁ  ଚତୁ ର୍ଥ  ସ୍ଥାନରେ V ବସି ଛି  । V ର ବାମ ପଟକୁ  ଦ୍ୱି ତୀୟ ସ୍ଥାନରେ T ବସି ଛି  ।
P ର ଡାହାଣ ପଟକୁ  ତୃ ତୀୟ ସ୍ଥାନରେ S ବସି ଛି  । S ର ଠି କ ବାମ ପଟକୁ  R ବସି ଛି  । Q ର
ଠି କ ଡାହାଣ ପଟକୁ  କି ଏ ବସି ଛି ?

A.  U

B.  S

C.  T

D.  V

✓

Q92 Reasoning
A ର ବାପା B ର ଭାଇ ଏବଂ ଏକମାତ୍ର  ଭାଇ/ଭଉଣୀ ଅଟନ୍ତି  । B C ର ପୁ ଅ ଅଟନ୍ତି  । A ର
ବାପାଙ୍କ ଭାଇଙ୍କ ସ୍ତ୍ରୀ K ଅଟନ୍ତି  । D B ର ପୁ ଅ ଅଟେ ଏବଂ E D ର ଭଉଣୀ ଅଟେ । E ସମ୍ପର୍କ ରେ
A ର କ'ଣ ହେବେ?

A.  ବାପାଙ୍କ ଭଉଣୀଙ୍କ ଝି ଅ

B.  ଝି ଅ

C.  ବାପାଙ୍କ ଭାଇଙ୍କ ଝି ଅ

D.  ଭାଇଙ୍କ ଝି ଅ

✓

Q93 Reasoning
ପ୍ରା ଣ ବି ନ୍ଦୁ  A ରୁ  ଆରମ୍ଭ କରି  ଉତ୍ତର ଦି ଗକୁ  38 km ଗାଡି  ଚଲାନ୍ତି  । ତା' ପରେ ସେ ବାମ
ମୋଡ଼ ନେଇ 42 km ଗାଡି  ଚଲାନ୍ତି  ସେ ପୁ ନର୍ବା ର ବାମ ମୋଡ଼ ନି ଅନ୍ତି  ଏବଂ 57 km ଗାଡି
ଚଲାନ୍ତି  । ଏହା ପରେ ସେ ବାମ ମୋଡ଼ ନେଇ 64 km ଗାଡି  ଚଲାନ୍ତି  । ସେ ଶେଷ ବାମ ମୋଡ଼
ନି ଅନ୍ତି  ଏବଂ 19 km ଗାଡି  ଚଲାଇ ବି ନ୍ଦୁ  P ରେ ଅଟକି ଯାଆନ୍ତି  । ବି ନ୍ଦୁ  A ରେ ପୁ ନର୍ବା ର
ପହଞ୍ଚି ବା ପାଇଁ  ସେ କେତେ ଦୂ ର (ସର୍ବ ନି ମ୍ନ  ଦୂ ରତା) ଏବଂ କେଉଁ  ଦି ଗକୁ  ଗାଡି  ଚଲାଇବା
ଉଚି ତ? (ଯଦି  ଦି ଆଯାଇ ନାହିଁ ତେବେ ସମସ୍ତ ମୋଡ କେବଳ 90° ଅଟେ ।)

A.  20 km ପଶ୍ଚି ମକୁ

B.  21 km ପଶ୍ଚି ମକୁ  

C.  22 km ପଶ୍ଚି ମକୁ

D.  23 km ପୂ ର୍ବ କୁ

✓

Q94 Reasoning
ଇଂରାଜୀ ବର୍ଣ୍ଣ ମାଳା କ୍ର ମ ଆଧାରରେ GLAD ଏକ ନି ର୍ଦ୍ଦିଷ୍ଟ ଉପାୟରେ INEH ସହି ତ
ସମ୍ପର୍କିତ । KPIL ସେହି  ସମାନ ଉପାୟରେ MRMP ସହି ତ ସମ୍ପର୍କିତ । ସମାନ ତର୍କ
ଅନୁ ସରଣ କରି  ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  କେଉଁ ଟି  ସହି ତ OTQT ସମ୍ପର୍କିତ ହେବ?

A.  QVUX

B.  PAUVW

C.  RWTY

D.  QWVY

✓

Q95 Reasoning
ସାତୋଟି  ବାକ୍ସ Q, R, W, T, E, U ଏବଂ Y ଗୋଟି ଏ ଉପରେ ଅନ୍ୟଟି  ରଖାଯାଇଛି , କି ନ୍ତୁ
ସେଗୁ ଡ଼ି କ ଏହି  କ୍ର ମରେ ରହି ବା ଜରୁ ରୀ ନୁ ହେଁ  । Y ର ଉପରେ କେବଳ ତି ନୋଟି  ବାକ୍ସ
ରଖାଯାଇଛି । U ଏବଂ Y ମଧ୍ୟରେ କେବଳ ଗୋଟି ଏ ବାକ୍ସ ଅଛି  । U ଏବଂ T ମଧ୍ୟରେ କେବଳ
ତି ନୋଟି  ବାକ୍ସ ରଖାଯାଇଛି  । Tକୁ  Y ଉପରେ କୌଣସି  ଏକ ସ୍ଥାନରେ ରହି ଛି  । W କୁ  T ର ଠି କ୍
ତଳେ ରଖାଯାଇଛି  । R କୁ  E ଉପରେ କୌଣସି  ଏକ ସ୍ଥାନରେ ରଖାଯାଇଛି  । Q କୁ  U ର ଠି କ୍
ଉପରେ କି ମ୍ବା ତଳେ ରଖାଯାଇନାହିଁ ।
W ର ଉପରେ କେତୋଟି  ବାକ୍ସ ରଖାଯାଇଛି ?

A.  1

B.  2

C.  3

D.  4

✓

Q96 Reasoning
ଯଦି  '+' ଓ '−' କୁ  ପରସ୍ପର ମଧ୍ୟରେ ଅଦଳବଦଳ କରାଯାଏ ଏବଂ '×' ଓ '÷' କୁ  ପରସ୍ପର
ମଧ୍ୟରେ ଅଦଳବଦଳ କରାଯାଏ, ତେବେ ନି ମ୍ନ ଲି ଖି ତ ସମୀକରଣରେ '?' ସ୍ଥାନରେ କ'ଣ
ହେବ?

33 ÷ 3 + 19 × 19 − 2 = ?

A.  90

B.  95

C.  102

D.  100

✓

Q97 Reasoning
ଇଂରାଜୀ ବର୍ଣ୍ଣ ମାଳା କ୍ର ମ ଆଧାରରେ ପ୍ର ଦତ୍ତ ଅନୁ କ୍ର ମରେ (?) ସ୍ଥାନରେ କ'ଣ ହେବ?
GDC JFF MHI PJL ?

A.  NJH

B.  TRE

C.  SLO

D.  JUY

✓

Q98 Reasoning
ଇଂରାଜୀ ବର୍ଣ୍ଣ ମାଳା କ୍ର ମ ଆଧାରରେ ନି ମ୍ନ ଲି ଖି ତ ଚାରୋଟି  ମଧ୍ୟରୁ  ତି ନୋଟି  ଏକ ନି ର୍ଦ୍ଦିଷ୍ଟ
ଉପାୟରେ ସଦୃ ଶ ଅଟନ୍ତି  ତେଣୁ  ଏହି ପରି  ଏକ ଗୋଷ୍ଠୀ ଗଠନ କରନ୍ତି  । କେଉଁ ଟି  ସେହି
ଗୋଷ୍ଠୀର ଅନ୍ତର୍ଭୁ କ୍ତ ନୁ ହେଁ ?
(ଦ୍ର ଷ୍ଟବ୍ୟ: ଅସାମଞ୍ଜସ୍ୟଟି  ବ୍ୟଞ୍ଜନବର୍ଣ୍ଣ /ସ୍ୱରବର୍ଣ୍ଣ  ସଂଖ୍ୟା କି ମ୍ବା ଅକ୍ଷର ପୁ ଞ୍ଜରେ ସେମାନଙ୍କର
ସ୍ଥି ତି  ଉପରେ ଆଧାରି ତ ନୁ ହେଁ  ।)

A.  SXZ

B.  TXA

C.  XBE

D.  EIL
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✓

Q99 Reasoning
ଦି ଆଯାଇଥି ବା ବି ବୃ ତି  ଓ ନି ଷ୍କର୍ଷ  ଗୁ ଡ଼ି କୁ  ଧ୍ୟାନ ପୂ ର୍ବ କ ଅଧ୍ୟୟନ କର । ସାଧାରଣ ଜଣାଶୁ ଣା
ତଥ୍ୟ ଠାରୁ  ଭି ନ୍ନ ବୋଲି  ପ୍ର ତୀତ ହେଲେ ମଧ୍ୟ ଏହି  ବି ବୃ ତି  ଗୁ ଡ଼ି କୁ  ସତ୍ୟ ବୋଲି  ବି ବେଚନା
କରନ୍ତୁ ଏବଂ ବି ବୃ ତି ରୁ  ତର୍କ ସି ଦ୍ଧ ଭାବରେ ଅନୁ ସୃ ତ ନି ଷ୍କର୍ଷ ଟି /ଗୁ ଡ଼ି କ ନି ର୍ଣ୍ଣ ୟ କରନ୍ତୁ ।
ବି ବୃ ତି : ସମସ୍ତ ଆଗ୍ନେୟଗି ରି  ହେଉଛି  ସୁ ନାମି  । ସମସ୍ତ ସୁ ନାମି  ହେଉଛି  ଭୂ ମି କମ୍ପ ।
ନି ଷ୍କର୍ଷ  I: ସମସ୍ତ ଭୂ ମି କମ୍ପ ହେଉଛି  ଆଗ୍ନେୟଗି ରି  ।
ନି ଷ୍କର୍ଷ  II: କି ଛି  ଭୂ ମି କମ୍ପ ହେଉଛି  ଆଗ୍ନେୟଗି ରି  ।

A.  କେବଳ ନି ଷ୍କର୍ଷ  (I) ଅନୁ ସରଣ କରେ

B.  କେବଳ ନି ଷ୍କର୍ଷ  (II) ଅନୁ ସରଣ କରେ

C.  ନି ଷ୍କର୍ଷ  (I) କି ମ୍ବା (II) ଅନୁ ସରଣ କରେ ନାହିଁ

D.  ଉଭୟ ନି ଷ୍କର୍ଷ  (I) ଏବଂ (II) ଅନୁ ସରଣ କରନ୍ତି

✓

Q100 Reasoning
ନି ମ୍ନ ଲି ଖି ତ ଅନୁ କ୍ର ମ ଆଧାରରେ ପ୍ର ଶ୍ନ ର ଉତ୍ତର ଦି ଅନ୍ତୁ । (ସମସ୍ତ ସଂଖ୍ୟା କେବଳ ଏକ ଅଙ୍କ
ବି ଶି ଷ୍ଟ ସଂଖ୍ୟା ଅଟେ । ଗଣନା କେବଳ ବାମରୁ  ଡାହାଣକୁ  କରାଯି ବ ।)
(ବାମ) 1 8 7 2 6 7 9 8 6 4 7 9 3 1 8 7 5 8 3 4 5 6 4 2 3 5 2 5 (ଡାହାଣ)
ଏପରି  କେତେଟି  ଯୁ ଗ୍ମ  ଅଙ୍କ ଅଛି , ଯାହାର ପ୍ର ତ୍ୟେକର ଠି କ ପୂ ର୍ବ ରୁ  ଏକ ଯୁ ଗ୍ମ  ଅଙ୍କ ଏବଂ ଠି କ
ପରେ ଏକ ଅଯୁ ଗ୍ମ  ଅଙ୍କ ମଧ୍ୟ ଅଛି ?

A.  ତି ନି ରୁ  ଅଧି କ

B.  ଏକ

C.  ଦୁ ଇ

D.  ତି ନି
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